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Conceptual Framework  
 
 
Food Insecurity and Vulnerability 
 

Food security exists when all people, at all times, have physical, social, and economic access to 
sufficient, safe, and nutritious food to meet their dietary needs and food preferences for an active and 
healthy life. (World Food Summit, 1996) Household food security is the application of this concept at 
the family level, with individuals within households as the focus of concern. 
 
For the purpose of FIVIMS, food insecurity exists when people are undernourished as a result of the 
physical unavailability of food, their lack of social or economic access to adequate food, and/or 
inadequate food use. Food insecure people are those individuals whose food intake falls below their 
minimum calorie (energy) requirements, and those who exhibit physical symptoms caused by energy 
and nutrient deficiencies resulting from an inadequate or unbalanced diet or from the body's inability 
to use food effectively because of infection or disease. 
 

 
In the context of Lao PDR, food security is defined as: “to ensure enough food and food stuff for 
every person at any time, both in material and economic aspects, with increasing demand on 
nutrition quality, hygiene, and balance so as to improve health and enable normal development 
and efficient work.” (Food Security Strategy, 2001-2010, MAF) 
 

 
Vulnerability refers to the full range of factors that place people at risk of becoming food insecure. 
The degree of vulnerability of individuals, households, or groups of people is determined by their 
exposure to risk factors and their ability to cope with or withstand stressful situations (Figure 1). In 
the Lao FIVIMS context, vulnerable people are those who face a high likelihood of experiencing 
food scarcity and falling into food (and nutrition) insecurity in the future. 
 
To achieve a success, strategies to eliminate food insecurity have to tackle these underlying causes by 
combining the efforts of those who work in diverse sectors such as agriculture, nutrition, health, 
education, social welfare, economics, public works, and the environment. At the national level, 
different ministries or departments need to combine their complementary skills and efforts to design 
and implement integrated cross-sectoral initiatives which must be synchronized with policies. At the 
international level, a range of specialized agencies and development organizations must work 
together in synergy as partners in a common effort. Figure 1 illustrates a food security continuum 
classifying population groups according to their current status: food insecure people, vulnerability 
people and food secure people. 

 



 2

 
Figure 1 – Food Security Continuum adopted from Making FIVIMS Work for You - Tools and Tips (FAO, 2002)
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Operational Framework and Methodology 
 
 
Definition, Rationale, Computation and Sources of Indicators 
 

The LAO FIVIMS Secretariat, in close cooperation with all concerned government institutions and 
NGOs, assembles, analyzes and disseminates through various forms of reports, information on food 
insecurity and vulnerability including those who are vulnerable or at risk of becoming food insecure. 

  
Data Sources and Collection 
 
The LAO FIVIMS Secretariat receives data from national and provincial departments of concerned 
sectors, the UN, international organizations, and non-governmental organizations (NGOs). All of 
these organizations are data collectors as well as data users. They play vital roles in providing and 
sharing information related to food insecurity and vulnerability. They can provide the information 
needed for the efficient and effective operation of FIVIMS. The main information providers are the 
MAF, DoS under MPI, MoH, MoE, WFP and FAO, through the conduct of censuses and other 
special surveys. The development of an appropriate mechanism for networking among information 
providers has been a major challenge for FIVIMS. 
 
Data and various information on FIVIMS will be collected and maintained in a database by the Core 
Analysts Group. Timing of data collection depends on types, frequency, and availability of data 
needed – e.g. yearly, seasonal, or once every two years, etc.  
 
FIVIMS Data Management and Dissemination 
 
While at present no FIVIMS database exists, the long-term goal for Lao FIVIMS is to develop a 
FIVIMS database – a recognized important step towards making Lao FIVIMS viable and useful. The 
information gathered by the members of the Core Analysts Group and the national FIVIMS 
Secretariat from respective line ministries, international organizations, and NGOs are collated and 
stored in a FIVIMS master data base. In the relational database, data and information are organized 
and updated for easy retrieval and further statistical analysis. For this purpose, FIVIMS adopts 
administrative area codes developed by MPI, which are commonly used by other governmental 
agencies, to store and maintain time series tabular data – e.g., provincial, district, cluster of villages, 
and village-level data.  The official administrative codes for provinces are found in the next chapter 
“Data Analysis Methodology”. 
 
For rapid data dissemination and sharing, the collected and analyzed data and outcome food and 
nutrition insecurity and vulnerability information are imported, managed and published in the 
Interactive FIVIMS Data Mapper (IFDM). IFDM allows easy data and information update and 
retrieval, tabulation, charting and graphing by using any web browsers (Figure 2). Lao IFDM is 
operable on individual PCs, accessible online, and distributed on CD-ROMs to FIVIMS stakeholders 
and users. The online system is currently hosted by an Asia-FIVIMS server in Bangkok, Thailand 
(http://www.asiafivims.net/lao/page.jspx) but will be transferred to a Lao domestic server when it 
becomes technically feasible. For more detailed system operations, please refer to IFDM User’s 
Manual To Organize, Maintain and Publish Your Data in the Web-Based Dynamic Mapping System 
downloadable from “HELP” in the system menu. 
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Figure 2 – Lao Interactive FIVIMS Data Mapper (http://www.asiafivims.net/lao/page.jspx) 



 5

Organization and management 
 
Figure 3 shows the Lao FIVIMS organizational structure while Figure 4 illustrates the networking, 
linkages and coordinating mechanisms between data generators and data users. The MAF Department 
of Planning is the overall coordinator for FIVIMS related activities and the focal agency of Lao 
FIVIMS. For more detailed descriptions of the responsibilities assumed by each FIVIMS entity, please 
refer to Annex. 
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Figure 3 – Lao FIVIMS Organizational Framework 

 
Figure 4 – Networking, linkages and coordination mechanism of Lao FIVIMS
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FIVIMS Indicators 
 
One of the basic principles of FIVIMS is not to introduce a totally new to build on the existing data 
and information systems in the country. Selection of indicators also followed this principle. There is a 
need to define appropriate and suitable core indicators for FIVIMS to measure the food insecurity and 
vulnerability situation in the country and to answer the basic FIVIMS questions: “Who are food 
insecure and vulnerable?”, “Where are they located?”, “Why are they food insecure and vulnerable?”,  
“How many are they?”, and “What can be done about it ?” 
 
Figure 6 shows how the interrelatedness of the various factors could contribute to addressing food 
security, nutrition, and poverty problems. The final set of indicators adopted for Lao FIVIMS is 
carefully selected based on this conceptual-analytical framework and also as a result of a series of in-
depth consultations with the FIVIMS Focal Points Committee members, Core Analysts Group, and 
stakeholders from both national and international organizations and NGOs. Some of the indicators 
are associated with the indicators of the National Growth and Poverty Eradication Strategy (NGPES), 
the Lao PDR Millennium Development Goals (MDGs), and other major national initiatives on 
poverty reduction and food security.  
 

 
Food Availability and Stability 
1. Per capita cultivated area for wet (lowland and upland) and dry season rice 
2. Per capita harvested area for wet (lowland and upland) and dry season rice 
3. Rice production surplus or deficit ratio 
4. Per capita rice planted area destroyed by drought 
5. Per capita rice planted area destroyed by flood 
6. Percentage of households affected by natural calamities 
7. Rainfall distribution  
8. Variability of rice production 
9. Percentage of agriculture in gross domestic product (GDP) 
 
Food Accessibility 
10. Percentage of households involved in cash crop production 
11. Percentage of households owning cattle and/or pigs 
12. Percentage of farm households owning land less than or equal to 0.5 hectare (ha) for planting  
13. Percentage of landless households 
14. Access to forested areas (non‐timber forest products) per household 
15. Percentage of their own household agricultural production sold in market 
16. Adult literacy/Illiteracy rate 
17. Dropout rate 
18. Dependency ratio 
19. Poverty headcount ratio 
20. Proportion of people living below the national poverty line 
21. Annual growth rate of labor force                 
22. GDP per capita 
23. Consumer price index (CPI) 
24. Road density 
 
Food Utilization and Consumption Outcome and Nutritional Status 
25. Under‐five mortality rate 
26. Infant mortality rate 
27. Prevalence of underweight children under five years old 
28. Prevalence of stunting among children under five years old 
29. Prevalence of wasting among children under five years old 
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30. Prevalence of underweight among adults (BMI < 18.5) 
31. Low birth weight (LBW) rate 
32. Maternal mortality rate 
33. Proportion of population below minimum level of dietary energy consumption (DEC) 
34. Prevalence of anemia among under five years old 
35. Prevalence of anemia among the general population 
 
Related Risk Factors 
36. Prevalence of malaria (suspect cases)  
37. Percentage of population in malaria risk areas protected by impregnated bed nets (IBN) 
38. Prevalence of tuberculosis (TB) 
39. Incidence of diarrhea 
40. Percentage of population using clean water for drinking and cooking 
41. Prevalence of HIV/AIDS among 15‐24 year old commercial service women 
42. Percentage of exclusive breastfeeding 
43. Life expectancy 
44. Population growth rate 
45. Percentage of rural population 
46. Unexploded ordinance (UXO) impact 
 

  
  

 
Figure 5 – Conceptual-Analytical Framework on Food Security, Livelihood and Nutrition 

(Source: FAO-FIVIMS Programme)
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Data Analysis Methodology 
 
 
Data Analysis Procedure – Overview 
 

A basic idea of Lao FIVIMS data analysis is to identify areas at a most possible heterogeneous level. 
Thus, the most important aspect of this framework is that it leads analysts to identify the particulars 
of more localized areas – specifically lower level administrative units – whereby the efforts on 
development and poverty eradication programmes can be implemented more efficiently and 
effectively in a local context. However, the spatial dimensions observed in two most important 
FIVIMS factors – food and nutrition insecurity and vulnerability – vary across geographical regions. 
Therefore, the spatial representation of these data is an important step to identify the spatial 
variability across regions. It allows more effective focusing on food insecure and vulnerable areas. 
 
In this volume, methods of mapping geographical distributions of food and nutrition insecurity and 
vulnerability are expatiated on through the use of scientific and statistical analysis of secondary data 
collected by surveys and censuses, administrative records, spatial data sources, and statistical 
modelling. It describes data analysis procedures step-by-step and presents model outputs – e.g. a map 
of relative food and nutrition insecurity by province. As the usefulness of outputs depends profoundly 
on the quality of input data, FIVIMS analysts and the users of this Manual are strongly recommended 
to scrutinize the accuracy and reliability of input data and to carefully review the validity of 
outputs through expert consultations or peer reviews before officially releasing the results to 
the public. 

 
 
Data Processing and Analysis with SPSS 
 

Step 1 – Identification of Spatial Units and Level of Analysis 
 
The first step of the procedure involves the identification of locations where the analysis should be 
performed. In addition, the level of administrative boundaries at which the analysis is to be performed 
should be determined according to the requirements of the FIVIMS analysts. The data availability at 
the chosen spatial level should also be considered in this selection.1 To perform the analysis, the 
following specifications apply (Table 1): 

 
Table 1 – Baseline geographic units and province codes 

Country Lao PDR 
Administrative Boundary Level of Analysis Provinces 

Province Code Province Name Province Code Province Name 
1 Vientiane (capital, municipality) 10 Vientiane 
2 Phongsaly 11 Borikhamxay 
3 Luangnamtha 12 Khammouane  
4 Oudomxay 13 Savannakhet 
5 Borkeo  14 Saravane  
6 Luangprabang 15 Sekong 
7 Huaphanh 16 Champasack 
8 Xayabuly 17 Attapeu 
9 Xiengkhuang 18 Xaysomboun (special region ) 

 

                                                 
1 All variable data used in this Manual – i.e. the data provided in Excel format – conform to the provincial boundaries as 

of March 2007. Thus the users can apply the most recent provincial classification once corresponding tabular data 
becomes available. 
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Step 2 – Identification of Information Sources 
 

The indicators to represent food and nutrition insecurity and vulnerability are usually determined 
using the data available at different administrative levels. For this Manual, the available data were 
obtained from the secondary data sources of different government and non-governmental 
organizations. Major sources of information are: 

 
 

 MAF: Agricultural Census and Crop Cutting Surveys 
 DoS under MPI: Population Census, LECS I, I and III, LNHS and LRHS (in collaboration 

with MoH) 
 MoH: through their Malaria, TB and AIDS-STD centres and NIOP 
 MoE: Annual School Censuses 
 NDMO: Surveys 

 
 
 

Step 3 – Determination of Vulnerability Indices 
 

The data analysis is expected to derive three different indices from the three categories of variables in 
order to reveal the status of population groups concerned – in this analysis, provincial administrative 
units – in terms of their relative vulnerability to food and nutrition insecurity associated with 
respective categories. 
 

 
i. Food Availability and Stability Index  
ii. Food Accessibility Index 
iii. Related Risk Factors Index 
 

 
Secondly, the overall relative vulnerability – or probability of falling into poor nutritional status and 
poor food utilization and consumption outcome – can be identified by taking all the aspects of the 
three categories into consideration. 
 

 
iv. Overall Vulnerability Index 
 
 derived from food availability/stability, accessibility and related risk factors 
 

 
In addition, an index to represent the current food and nutrition insecurity or risk situation can be 
computed from the food utilization and consumption outcome and nutritional status category.2 
 

 
v. Food Utilization and Consumption Outcome and Nutritional Status Index 
 

 
Tables 2 presents selected FIVIMS indicator variables, for which data are available from the line 
ministries and FIVIMS partners, as well as additional and proxy variables considered useful for 
deriving the respective indices. 

                                                 
2  Since the data for this category are not available at the time of writing this Manual except for the infant mortality rate 

and the percentage of population adequately iodized which is a proxy variable for anemia, the calculation of the index 
of the category was not performed. 
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Table 2 – List of variables available and considered useful for FIVIMS analysis 
Food Availability and Stability Related Risk Factors 

Rice planted area per person (ha) Improved water source (%) 
Rice harvested area per person (ha) Life expectancy 
Amount of rice produced per person Malaria cases 
Rice cultivated area damaged by drought per person 
(ha) 

Percentage of population consuming clean water 

Rice cultivated area damaged by flood per person (ha) Percentage of population using latrine 
Number of buffaloes Prevalence of Tuberculosis (TB) 
Rice planted area per person (ha) Number of AIDS cases 
Number of pigs Population growth rate (%) 
Number of poultry  
Number of cattle  
Number of goats and sheep  
Daily rice intake per capital (grams)  
Percentage of households affected by natural calamities  
Areas hit by natural disasters  
Instability of paddy production over time  
  

Food Accessibility Food Utilization and Consumption Outcome and 
Nutritional Status 

Dependency ratio (%) Infant mortality rate 
Adult literacy rate (2001) Percentage of population adequately iodized (%) 
Dropout rates (primary and secondary education)  
Dropout rate (primary)  
Dropout rate (secondary)  
Dropout rate (high school)  
Pupils per primary school teacher  (2002/03)  
GDP per capita (PPP US$)  
Poverty headcount ratio (%)    
Percentage of households involved in cash crop 
production 

 

Annual growth rate of labour  
Percentage of farm households having planting 
land<0.5 (ha) 

 

Percentage of landless households (%)  
Average household size (persons per household)  
Human Development index (HDI) value    
Economic activity rate (%, 2002/03) or the proportion 
of working population above 10 years old 

 

Proportion of villages with electricity (%)  
Proportion of villages reachable batteries in dry season 
(%) 

 

Proportion of villages reachable batteries in rainy 
season (%) 

 

Proportion of villages with bus stop in village (%)  
Average distance from a village to  nearest road (km)    
Average distance from a village to public transport (km)  
Average distance from a village to post office (km)  
Percentage of rural areas (%)  
Percentage of food expenditure in total expenditure (%) 
or proportion of consumption of food in total 
consumption 

 

Percentage of households owning animals (%)  
Percentage of rural population (%)  
Proportion of consumption from their own production 
in total consumption (%)   
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Step 4 – Spreadsheet Data Formatting and Preparation for Analysis 
 

The following procedure is taken to prepare data sets using Microsoft Excel. Once the data are saved 
in a proper spreadsheet and file format, they will be imported into the SPSS statistical analysis 
package later. 

 
① The spreadsheet data processing is performed using the ‘Microsoft Excel’ software package. 
 
② The data are selected based on the logical conceptual framework outlined in Step 3, the FIVIMS 

indicators, and Figure 5.  
 

③ The selected data are needed to be arranged in a spreadsheet for each of the category. 
 

 

All the missing data should be filled either from average values or through the use of a 
scientific method such as interpolation and simulation methods. 
 

 If a particular value for a province is not available, then the national average is calculated 
and the missing value is replaced with the national average, or the empty Excel sheet 
cells are filled with the average values. 
 

④ Examples of the arranged data for each category are presented in Tables 3-8. 
 

 

The redundancy of information is a common phenomenon, when a large number of 
indicators are used due to the provision of similar information. 
 
A correlation analysis is carried out in order to eliminate the variables that are 
highly correlated through a correlation matrix. 
 
Therefore, not all indicators identified are used for actual computation of vulnerability 
indices. For example, for the food accessibility analysis, Proportion of Villages with 
Electricity, Proportion of Villages Reachable Batteries in Rainy Season, and Proportion 
of Villages with Bus Stop in Village are removed because they are highly correlated each 
other, in addition to Human Development Index that is itself a composite of other 
variables or factors (Table 2). 
 

⑤ The coding system provided by MoP is used in the analysis to represent the variables. 
 
 



 12

Table 3 – Final list of variables used for food availability and stability analysis 
Province Code Province Name rcpltd rchvd rcprod drut flod buff pigs poult catt gadsh rcint hhnc ntdis instp 

1 Vientiane (capital, municipality) 0.11 0.11 0.437 0 0.002 18 99 263 65 14.4 478 0.01 1,385 3 
2 Phongsaly 0.09 0.09 0.223 0.0005 0 33 71 412 20 1.9 592   1 
3 Luangnamtha 0.14 0.14 0.421 0.0004 0 24 60 349 24 5.6 702 0.05  3 
4 Oudomxay 0.1 0.1 0.3 0.0051 0.0003 38 90 734 29 13.6 644 0.03 70 3 
5 Borkeo  0.12 0.12 0.425 0 0.0004 21 44 425 26 4.4 637 0.08 60 1 
6 Luangprabang 0.09 0.09 0.206 0 0.0005 57 151 1345 39 36.1 608 0.01 245 1 
7 Huaphanh 0.09 0.09 0.259 0.0001 0.0005 63 234 1907 47 15.7 649 0.12 160 2 
8 Xayabuly 0.12 0.12 0.375 0.0001 0.0002 62 86 1999 65 8 704 0.01 85 2 
9 Xiengkhuang 0.11 0.1 0.302 0 0.0003 44 76 793 89 6.7 672 0.01 90 3 

10 Vientiane 0.13 0.13 0.548 0 0.0031 60 86 1743 106 10.7 573  1,165 4 
11 Borikhamxay 0.16 0.15 0.618 0 0.0114 42 54 688 52 2.1 532 0.16 2,445 2 
12 Khammouane  0.17 0.1 0.349 0 0.0644 66 91 1117 51 7.2 717 0.45 22,990 5 
13 Savannakhet 0.2 0.18 0.562 0 0.0182 282 263 2289 387 39.2 452 0.07 16,045 5 
14 Saravane  0.22 0.22 0.733 0 0.0099 87 232 2675 105 11 597 0.08 3,340 4 
15 Sekong 0.11 0.1 0.332 0 0.0011 23 46 133 16 5.6 533 0.97 90 1 
16 Champasack 0.16 0.15 0.465 0 0.0098 117 106 2410 123 2.8 502 0.06 6,470 5 
17 Attapeu 0.18 0.16 0.502 0 0.0234 44 19 360 12 2.3 573 0.13 2,680 5 
18 Xaysomboun (special region ) 0.12 0.12 0.195 0.0006 0 16 19 160 16 2.7 740   3 

 
Table 4: Codes for food availability and accessibility variables 

Code Variable Name Code Variable Name 
rcpltd Rice planted area per person poult Number of poultry 
rchvd Rice harvested area per person catt Number of cattle 
rcprod Amount of rice produced per person gadsh Number of goats and sheep 
drut Rice cultivated area damaged by drought per person rcint Daily rice intake per capital (grams) 
flod Rice cultivated area damaged by flood per person hhnc Percentage of households affected by natural calamities 
buff Number of buffaloes ntdis Areas hit by natural disasters 
pigs Number of pigs instep Instability of paddy production over time 
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Table 5 – Final list of variables used for food accessibility analysis 
Province Code Province Name dr Lr tdr pps gdp phr hhi agw fhh llh avhh ear din ra fexp hhoa rup totslf 

1 Vientiane (capital, municipality) 46 90 8.85 22 2516 17 7.2 1.5 9.72 2.08 5.7 82 3 87 57 66.9 95 6 
2 Phongsaly 85 47 15.70 37 942 51 1.2 1.1 9.80 7.84 5.9 84 5 74 62 92.8 94 57 
3 Luangnamtha 74 48 11.00 31 1462 23 1.5 1.3 22.58 3.23 5.7 76 8 92 67 94.7 95 41 
4 Oudomxay 87 55 14.67 32 931 45 3.9 1.3 3.99 8.28 5.8 85 2 77 58 74.5 87 49 
5 Borkeo  77 60 11.50 16 1198 21 7.4 1.3 15.26 0.27 6.5 88 9 84 65 94.6 94 50 
6 Luangprabang 83 58 9.36 25 1377 40 3.2 1.2 18.29 6.41 5.5 86 1 81 64 79.1 87 25 
7 Huaphanh 98 57 9.95 18 1077 52 0.5 1.2 17.44 2.56 5.6 83 16 80 58 87.9 83 50 
8 Xayabuly 69 74 5.41 29 1513 25 8.3 1.3 5.84 1.64 5.8 80 10 80 52 88.2 89 33 
9 Xiengkhuang 97 70 7.65 14 1100 42 0.7 1.3 9.64 2.41 6.2 83 7 81 65 91.3 85 42 

10 Vientiane 72 75 7.86 15 1606 19 5.0 1.5 27.57 0.00 5.7 90 16 85 69 89.3 94 23 
11 Borikhamxay 84 76 7.70 27 1356 29 3.4 1.5 3.91 4.40 6.1 98 1 93 66 91.3 94 37 
12 Khammouane  83 67 12.52 25 1448 34 3.2 1.3 12.92 3.98 6.3 81 1 73 60 93.4 85 43 
13 Savannakhet 77 64 13.08 15 1448 43 1.9 1.3 5.26 1.05 6.8 89 12 83 68 90.7 85 34 
14 Saravane  91 47 15.90 19 889 54 7.5 1.3 20.71 20.47 5.6 75 0 19 42 74.5 37 48 
15 Sekong 96 67 16.08 23 1143 42 5.2 1.3 13.19 6.24 5.7 76 2 80 50 87.4 83 47 
16 Champasack 79 83 11.82 15 1469 18 19.9 1.3 14.43 3.71 5.4 84 2 79 50 91.5 93 23 
17 Attapeu 89 73 14.89 24 1290 44 2.0 1.3   6.2 78  82 65  92 38 
18 Xaysomboun (special region ) 92 66  18 1338 31  0.1 13.92 1.83 6.4 72 8 80 60 96.8 93 39 

 
Table 6 – Codes for food accessibility variables 

Code Variable Name Code Variable Name 
dr Dependency ratio llh Percentage of landless households 
lr Adult literacy rate (age 15 yrs and above) avhh Average household size (persons per household) 
tdr Dropout rates (primary and secondary education) ear Economic activity rate (proportion of working population above 10 years old) 
pps Pupils per primary school teacher number din Average distance from a village to nearest road 
gdp GDP per capita (PPP US$) ra Percentage of rural areas 
pgr Poverty headcount ratio fexp Percentage of food expenditure in total expenditure 
hhi Percentage of households involved in cash crop production hhoa Percentage of households owning animals 
agw Annual growth rate of labour rup Percentage of rural population 
fhh Percentage of farm households having planting land < 0.5 ha totslf Proportion of consumption from their own production in total consumption 
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Table 7 – Final list of variables used for related risk factors analysis 
Province Code Province Name iws lex mal clw late tuber aids 

1 Vientiane (capital, municipality) 0.92 69.50 1478.00 0.52 0.40 0.48 0.00 
2 Phongsaly 0.64 61.50 684.00 0.68 0.63 0.24 0.00 
3 Luangnamtha 0.85 57.50 89.00 0.73 0.56 0.43 0.03 
4 Oudomxay 0.69 59.00 1490.00 0.86 0.39 0.57 0.01 
5 Borkeo  0.73 64.50 1534.00 0.62 0.50 0.77 0.00 
6 Luangprabang 0.68 60.50 2157.00 0.62 0.39 0.09 0.01 
7 Huaphanh 0.62 61.50 3661.00 0.85 0.61 0.89 0.00 
8 Xayabuly  64.50 3532.00 0.68 0.40 0.20 0.00 
9 Xiengkhuang 0.57 61.50 2811.00 0.69 0.43 7.72 0.00 

10 Vientiane 0.71 66.50 107.00 0.64 0.21 0.57 0.00 
11 Borikhamxay 0.68 64.50 2436.00 0.80 0.26 0.12 0.00 
12 Khammouane  0.62 57.50 5034.00 0.82 0.23 0.14 0.04 
13 Savannakhet 0.82 61.50 981.00 0.67 0.33 3.84 0.00 
14 Saravane  0.80 57.50 4.00 0.92 0.87 0.04 0.02 
15 Sekong 0.67 55.00 89.00 0.71 0.53 0.24 0.00 
16 Champasack 0.86 61.50 3816.00 0.57 0.54 0.32 0.00 
17 Attapeu 0.52 56.50 110.00   2.48 0.00 
18 Xaysomboun (special region )  61.50 285.00   0.04 0.00 

 
Table 8 – Codes for the variables of related risk factors 

Code Variable Name 
iws Improved water source 
lex Life expectancy 
mal Malaria cases 
clw Percentage of population consuming clean water 
late Percentage of population using latrine 
tuber Prevalence of Tuberculosis (TB) 
aids Number of AIDS cases 
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Step 5 – Entering Data into SPSS 
 

The stepwise procedure for SPSS data analysis is given in this section including the procedure for 
eliminating correlated variables using correlation analysis. 
 
① Start > All Programs > SPSS for Windows > SPSS 
 
② To add the data to SPSS, go to File > Open > Data (Figure 6) 

 

 
 

Figure 6 – Opening data files 
 
③ Identify the file type of your data. If you have stored your data in Excel, you have to select 

*.xls. (Figure 7). 
 

 
 

Figure 7 – Selection of data file 
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④ Then, select the data file. 
 
Now the computer will ask you to identify the worksheet where you have stored your data. Suppose 
you have stored the food availability and accessibility data in two different worksheets of the same 
Excel file. To open the accessibility data saved in a worksheet named ‘Accessibility’, 
 
⑤ Change the worksheet to Accessibility and press OK. 
 
⑥ Select the range of your data – e.g. A1:J42 – and press OK (Figure 8). 

 

 
 

Figure 8 – Selection of the worksheet 
 
 

 

You need to be careful in preparing Excel data files. Your data should be numeric – i.e. 
numbers – and missing data cells should be empty. 
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Step 6 – Correlation Analysis 
 

To carry out correlation analysis, please follow the procedure below. 
 
① Select Analyze > Correlate > Bivariate (Figures 9 and 10) 

 

 
Figure 9 – Correlation analysis 

 
 

② Select Pearson and press OK. (Figure 13) 
 

 
 

Figure 10 – Selection of correlation coefficient type 
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③ SPSS outputs the correlation matrix as shown in Figure 11. 
 

 
Figure 11 – Correlation matrix 

 
 
④ In this stage, highly correlated variables are removed and the rest is used for further analysis.  

This can be done by exporting the correlation output data file to Excel (Figure 12). 
 

 
 

Figure 12 – Exporting correlation output data file to Excel 
 
⑤ Remove variables having the correlation coefficient greater than 0.8. 
 
⑥ Bring the new dataset back into SPSS. (Follow the same procedure given in Step 2.) 
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(I) Common Factor Analysis and Component Analysis 
 
Factor analysis in general includes principal component analysis. While the two techniques are 
functionally very similar and are used  for  the same purpose  (data  reduction),  they are quite 
different in terms of underlying assumptions. 
 
The  term  ‘common’  in  common  factor analysis describes  the  variance  that  is  analyzed.  It  is 
assumed  that  the  variance  of  a  single  variable  can  be  broken  down  into  common  (shared) 
variance  that  is shared by other variables which are  included  in  the model as well as unique 
(individual) variance that is peculiar to a particular variable and includes the error component. 
Common  factor  analysis  analyses  the  common  variance  of  the  observed  variables  only; 
principal component analysis considers the total variance and makes no distinction between 
common and unique variance. 
 
The selection of one technique over the other is based upon several criteria. First of all, what is 
the objective of  the analysis? Common  factor analysis and principal  component analysis are 
similar  in  the  sense  that  the  purpose of both  is  to  reduce  the original  variables  into  fewer 
composite variables, called factors or principal components. However, they are distinct  in the 
sense  that  the  obtained  composite  variables  serve  different  purposes.  In  common  factor 
analysis, a small number of factors are extracted to account for the  inter‐correlations among 
the  observed  variables  to  identify  the  latent  or  hidden  dimensions  that  explain  why  the 
variables are correlated with each other.  In principal component analysis,  the objective  is  to 
account for the maximum portion of the variance present in the original set of variables with a 
minimum number of composite variables called principal components. 
 
Secondly,  what  are  the  assumptions  about  the  variance  in  the  original  variables?  If  the 
observed variables are measured relatively error free – for example, age, years of education, or 
number of family members – or if it is assumed that the error and specific variance represent a 
small portion of the total variance in the original set of the variables, then principal component 
analysis is appropriate. But if the observed variables are only indicators of the latent constructs 
to be measured  (such as  test scores or responses  to attitude scales), or  if  the error  (unique) 
variance represents a significant portion of the total variance, then the appropriate technique 
to  select  is  common  factor analysis.  Since  the  two methods often  yield  similar  results, only 
Common factor analysis will be illustrated here and referred to as Factor Analysis. 
 
(II) Factor Analysis 
 
The basic  idea of  factor analysis  is  the  reduction of  set of observable variables  into a  set of 
latent or hidden  factors. This primarily uncovers  the  relationships among variables based on 
the assumption that partial correlation exists among the observed variables. 
 

Factor loadings 
Component Loadings in factor analysis are the correlation coefficients between the variables 
(rows) and  factors  (columns). Analogous  to Pearson’s  r,  the  squared  factor  loading  is  the 
percent of variance in that variable explained by the factor. 
 
Factor scores 
Factor  scores  are  computed  by multiplying  the  factor  score  by  the  corresponding  factor 
loadings of the variable for a given factor, and summing these products. The computation of 
factor  scores  allows  the  user  to  eliminate  the  outliers  and  do  the modelling  in  further 
analysis. 
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Rotation 
Rotation  makes  the  output  more  understandable  and  facilitates  the  interpretation  of 
factors. Though the sum of Eigen values is not affected by rotation, it alters the Eigen values 
and percent of variance explained by particular factors. As a result, the factor  loadings will 
be changed.   
 
Varimax Rotation 
While being the most common rotation option, this  is an orthogonal transformation of the 
factor axes to maximize the variance of the squared loadings of a factor on all the variables 
in a factor matrix, which has the effect of differentiating the original variables by extracted 
factors.  A varimax rotation will make it possible to identify each variable with a single factor 
and let each factor to have either large or small loadings of any particular variable.  
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Step 7 – Factor Analysis Procedure 
 
① The data sets are arranged to be analyzed with the SPSS statistical analysis package as discussed 

previously. 
 
② In cases where no data are available for a particular variable in a particular administrative 

location, the average value can be used to fill the data gaps as described earlier.  
 

③ A multivariate dimension reduction methodology known as Factor Analysis is used to reduce 
the total set of indicators to a few independent factors. 

 
④ On the menu, select Analyze > Data Reduction > Factor (Figures 13). The Factor Analysis 

window will appears (Figure 14). 
 

 
 
 

Figure 13 – Procedure for Factor Analysis 
 
 



 

 22

 
 

Figure 14 – Factor Analysis window 
 
 

⑤ Select the Descriptives button of the Factor Analysis window. Tick the appropriate Statistics and 
Correlation Matrix boxes as shown in Figure 15, and press Continue. 

 

 
 

Figure 15 – Factor Analysis: Descriptives window 
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⑥ Select the Extraction button of the Factor Analysis window, and choose the Principal 

components method. 
 
⑦ Tick the appropriate Analyze, Display, and Extract boxes as shown in Figure 16, and press 

Continue. 
 

 
 

Figure 16 – Factor Analysis: Extraction window 
 
 

⑧ Select the Rotation button of the Factor Analysis window. Tick the appropriate Method and 
Display boxes as shown in Figure 17, and press Continue. 

 
 

 
 

Figure 17 – Factor Analysis: Rotation window 
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⑨ Select the Scores button of the Factor Analysis window. Tick the Display factor score 
coefficient matrix box as shown in Figure 18, and press Continue and OK. 

 

 
 

Figure 18 – Factor Analysis: Factor Scores window 
 
 

⑩ Once you follow the procedure given above, the following results should be obtained (Tables 9a - 
b). 

 
⑪ Each factor is capable of explaining a large percentage of the total variation that exists in the 

indicators used for the analysis. 
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Table 9 (a) – Results of Factor Analysis 
 

Descriptive Statics           Communalities 

          
 

Correlation Matrix 

 
Extraction Method: Principal Component Analysis 
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Table 9 (b) – Results of Factor Analysis 
 

Total Variance Explained 

 
 
      Component Matrix    Rotated Component Matrix 
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Step 8 – Factor Extraction 
 
① The variation explained by each factor is represented with the Eigen value. 
 
② The Eigen value of each factor is used as its corresponding weight to the total variation. 

 
③ The number of factors to be extracted for the analysis is defined by the Eigen value. By 

convention, the values which are greater than one (1) are taken as the number of factors to be 
used in the analysis. 

 
④ If there are no differences observed in the initial factor analysis results and the rotated results, the 

initial results are used in the analysis. Otherwise it is preferred to use the results of the 
transformation. 

 
⑤ The comparison of the results of the initial analysis and the transformation is presented in the 

Table 10. 
 

Table 10 – Results of the factor analysis (Initial and Rotated) 

 
 

⑥ In this example, initial factor analysis results and rotated results are different. If the rotation 
results in a separation of the variables selected for the analysis, the objective of the rotation is 
achieved. For example, in the rotated component matrix in Table 11, every variable appears only 
in one factor except in the case of variable ‘llh’. Therefore, the rotated matrix was selected for 
further analysis. 

 
⑦ Variables with high factor loadings are selected for further analysis. In this example, variables 

with factor loadings above 0.5 were selected as given in Table 11.  
 

 

Value of Factor 1 = Real value of each variable contributing to Factor 1* Loading of the 
variable. 
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Table 11 – Extraction of variables with high factor loadings 
Rotated Component Matrix with High Factor Loadings 

Component 
  1 2 3 4 5 

pgr         0.795
lr -0.862         

tdr 0.693         
gdp -0.874         
phr 0.802         
hhi       0.768   
fhh           
llh 0.567 0.557       

avhh     0.883     
tfc     0.617     
pps       -0.691   
ear     0.676     
rer   0.764       
din   -0.874       

rcpld   0.721       
hhoa     0.575     
Extraction Method: Principal Component Analysis.  
 Rotation Method: Varimax with Kaiser Normalization. 
a. Rotation converged in 12 iterations. 
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Step 9 – Computation of Vulnerability Index (VI) for Each Category 
 
The extracted factors are combined into a single index called Vulnerability Index (VI) for each 
FIVIMS indicator category. 
 
① As the first step, the contribution of each factor to the total is calculated as a fraction. The 

required coefficients are given in Table 12. The % Variance column is copied from Table 03 
(Column: % Variance under the rotated sums of squared loadings). 

 
② The fraction coefficient is calculated as a ratio of % Variance of a given factor to Total % 

Variance multiplied by 100. For example, the coefficient for Factor 1 is calculated as follows 
(Equation 1): 

 
(Equation 1) 
 

CoeffientFraction  100
Variance % Total

Variance %
=×  

 

Fraction Coefficient for Factor 1 
 

0.28484647100
77.8443255
22.1735884

=×  

 
 
③ The VI equation is developed using the coefficients calculated in Table 12. 

 
Table 12 – Contribution of each factor to the total 

Factor % of Variance 
(from Table 3) Fraction Coefficient 

1 22.1735884 0.28484647 
2 20.6964072 0.26587029 
3 16.7597116 0.21529869 
4 10.3751146 0.13328085 
5 7.83950365 0.10070787 

Total 77.8443255 1.00000 
 

④ In Equation 2, the equation used to calculate VI for the food accessibility category is presented in 
Equation 2. 

         
(Equation 2) 
 
VI Access = 0.28 × Fac1 + 0.26 × Fac2 + 0.21 × Fac3 + 0.13 × Fac4 + 0.1 × Fac5 
 

where Fac1, Fac2……Fac5 are the values of extracted factors 
 

 
⑤ Likewise, VIs for the Food Availability and Stability category and the Related Risk Factors 

category can be calculated respectively according to the above methodology. 
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Step 10 – Computation of Overall Vulnerability Index 
 
To compute Overall Vulnerability Index (OVI), the contribution of each category – i.e. food 
availability/stability, accessibility and related risk factors – to OVI should be known. For this 
purpose: 
 
① VI for each category is ranked. You can use ranks from 1 to 5. 
 
② Equal Interval or Natural Breaks Classification criteria can be used in ranking VI for each 

category as shown in the next section. 
 

③ Run Factor Analysis again with the rank values for each administrative unit – district or 
province – to identify highly contributing factors. 

 
④ Identify the factor loadings to calculate the weight of each factor to the total vulnerability as 

given in Equation 3 
 

(Equation 3) 
 

∑
=

λ
λi

ia    where: ai = Weight of the ith  Factor   �i = Eigen value of ith Factor 

 
(Source: Food Insecurity and Vulnerability Assessment of Sri Lanka, 2006) 

 
 

⑤ Then, identify the vulnerability categories which contribute mostly to the extracted factors (as in 
Table 02). 

 
⑥ Calculate OVI according to Equation 4. 

 
⑦ For the purpose of balanced representation of the results, a constant P value for each category 

can be incorporated into the analysis. 
 

(Equation 4) 
 
Overall Vulnerability Index for an administrative boundary location = )*( PFXa ijji∑ ∑  
 

where     ai = Weight of the ith  Factor 
Xi = Rank value of the jth Category of the admin  

Fij = ith Factor loading of jth Rank value of Category 

P  = Constant for separate categories 

 
(Source: Food Insecurity and Vulnerability Assessment of Sri Lanka, 2006) 
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⑧ Constant P values are subjective and can be determined as follows according to the importance 

of each category to the overall food insecurity and vulnerability. 
 

(Example) 
 
P constant values for each category or index used in the analysis  
 

Food Availability and Stability Index = 0.4 
Food Accessibility Index = 0.4 
Related Risk Factors Index = 0.2 

 
 
 

⑨ Finally, the calculated VI value for each category as well as OVI values will be imported into the 
ESRI ArcView GIS software for mapping (see Step 12). 
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Step 11 – Time-Series Analysis 
 

The variability of values of the selected variables is calculated in order to obtain an idea about the 
instability of the variables over time. 
 
① For instance, the instability of paddy production is calculated, and the instability index is 

developed through computing correlation coefficients. 
 
② The equation of calculating the instability index is presented in Equation 5. 

 
(Equation 5) 
 
Instability = 1 - Correlation Coefficient of Linear Trend 
 

 
③ The calculation procedure in Excel is shown in Figure 19 and 20.  

 

 
 

Figure 19 – Display of how to choose Excel functions 
 
 

 
 

Figure 20 – Using CORREL in Excel 
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Data processing and analysis and map development using GIS 
 

Step 12 – Data Entry and Import into ArcView GIS 
 
① The first step to create maps is to launch ArcView GIS (Figure 21) from Microsoft Windows 

XP’s Start/Programs. 
 

 
 

Figure 21 – Running ESRI ArcView GIS from Microsoft Windows XP’s Start/Programs 
 
 
② Then, the shape file of the relevant administrative boundary should be opened in a View (Figure 

22). 
 

 
 

Figure 22 – Adding a Shape file (.shp) as a theme to a Viewer in ArcView GIS 
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③ It is displayed on the View window of ArcView GIS (Figure 23).  
 

 
 

Figure 23 – Displaying the Shape file of the provincial administrative boundaries of Lao PDR 
 
 

④ The relevant attribute file should be opened (Figure 24), and the table appears (Figure 25). 
 

 
 

Figure 24 – Menu option to open an attribute table 
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Figure 25 – Opening the attribute table 
 
 
⑤ Then, the editing mode should be invoked by selecting Theme on the menu bar and subsequently 

selecting Start Editing (Figure 26). 
 

 
 

Figure 26 – Activating the editing mode from Table/Start Editing 
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⑥ Select Add Field to add a new field column (Figure 27). 
 

 
 

Figure 27 – Menu option for adding a new field 
 
 

⑦ Define the new field by giving a name Food_access and the type of data as Number (Figure 28). 
 

 
 

Figure 28 – Naming the new field to Food_access and defining the data type 
 
 

 

ArcView GIS accepts only up-to-8-character field names so that the field name 
initially typed in – i.e. Food_access – is automatically changed to Food_acc. 
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⑧ Once the new field is added, you can enter the data into the new field (Figure 29). 
 

 
 

Figure 29 – Entering the data into the new field Food_acc 
 

 
⑨ When the data entry is over, on Editor, choose the option for Save Edits and then Stop Editing 

(Figure 30). 
 

 
 

Figure 30 – Saving the entered attribute data 
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Step 13 – Classification of Vulnerability Index Using Natural Breaks 
 
Natural Breaks Classification is one of the classification methodologies available in the ESRI 
ArcView GIS software. In the natural breaks classification, classes are grouped based on the natural 
groupings inherent in the data. Break points are determined by identifying class breaks that group the 
most similar values together and maximize the difference between the classes. 

 
① Double click on Legend to open up Legend Editor (Figure 31). 

 

 
 

Figure 31 – Legend Editor with a defined classification field 
 
 

② Under Classification select the field ‘Food_acc’. Then, select Classify to open up Classification 
Dialog. 

 
③ The number of classes is 5 and the type of classification is Natural Breaks (Figure 32).  

 

 
 

Figure 32 – Classification with Natural Breaks for 5 classes 
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④ In this process, the five categories identified in Natural Break Classification are renamed as 
follows.   

 
 

 Critically Vulnerable Area 
 Vulnerable Area 
 Moderately Vulnerable Area 
 Less Vulnerable Area 
 Least vulnerable Area 

 
 
 

 

When assigning the class names for vulnerability, the change of values towards 
decreasing order of vulnerability should be considered based on the actual class intervals 
defined by the natural breaks classification. 

 
 
⑤ After the labels of the legend are renamed, click OK and apply the classification to obtain the 

classified map (Figure 33). 
 

 
 

Figure 33 – A classified map as a result of using Natural Breaks Classification 
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Step 14 – Finalizing the Map Using Layout Template for Map Printing and Publishing 
 

① From the project window, select Layout and click on New (Figure 34). 
 

 
 

Figure 34 – Selecting Layout from the Project window 
 
 

② An empty new layout will appear (Figure 35). 
 

 
 

Figure 35 – Layout View 
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③ Use the menu item Layout and use the option for Use Template (Figure 36). 
 

 
 

Figure 36 – Using Use Template in the Layout window 
 
 

④ Select Portrait for the page orientation in Template Manager (Figure 37). 
 
 

 
 

Figure 37 – Selecting a page orientation on Template Manager 
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⑤ Insert a title, legend, scale, and the north arrow to generate a map of Food Accessibility (Figure 
38). 

 

 
 

Figure 38 – Food accessibility map in the Layout window 
 
 

⑥ Then, use Export under the File menu and define the file type and location for the file to be 
saved (Figure 39). 

 

 
 

Figure 39 – Export of the layout to a desired file format and location 
 
 

⑦ The exported map can be displayed on any graphic software. 
 
⑧ Apply the same mapping and classification procedures for all the categories – i.e. food 

availability, food accessibility, food instability, and related risk factors – separately and for the 
overall food security and vulnerability analysis. A map developed for the food availability 
category is presented in Figures 40. 
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Figure 40 – Sample output map showing relative vulnerability measured based on food availability factors 



 

 

 


